Each TechnoKids project consists of 6 sessions,

which are divided into separate assignments. An
assignment is an activity that takes about 20
minutes to complete.

Session 1
The TechnoStock Exchange
In this session, students become stockbrokers buying shares in companies listed
on the TechnoStock Exchange (TSE). They begin by learning about how the
stock market functions. Once familiar with this method of earning money,
students study company profiles to determine those that look to be a good
investment. They then buy shares in these companies receiving a stock
certificate as proof of the purchase. Using Microsoft Excel, students create a
table that contains information about their stocks, the amount purchased, and
their current market value. This electronic portfolio is updated each session, to
help students manage their investments.
Assignment 1: Introduction to Spreadsheets
Assignment 2: Introduction to Stock Market Terminology
Assignment 3: Playing the Stock Market
Assignment 4: Investment Record Trade 1
Assignment 5: Organize Investment Information using Excel
Session 1 Review Stock Market and Spreadsheet Checkup
Session 1 Extension Activity Track the Stock Market on the Internet

For the paperless classroom, each assignment, review, skill
review, and extension activity in the TechnoKids Student
Workbooks is also included as a digital file.

Some pages have been removed from this sample.

Session 1: The TechnoStock Exchange
Getting
Startedsession,
For every
Overview

the Teacher Guide

features:

In this session, students become stockbrokers buying shares in companies listed on the
TechnoStock Exchange (TSE). They begin by learning about how the stock market functions. Once
familiar with this method of earning money, students study company profiles to determine those
that look to be a good investment. They then buy shares in these companies receiving a stock
certificate as proof of the purchase. Using Microsoft Excel, students create a table that contains
information about their stocks, the amount purchased, and their current market value. This
electronic portfolio is updated each session, to help students manage their investments.

✓ an introduction with a materials list
✓ preparation advice
✓ teaching strategies

✓ lesson plans for each assignment

Materials
•
•

✓ learning objectives for the session
Microsoft Excel

Flashcards (Optional)
o

•

Teacher Resource
o

•

•

•

Investment Portfolio sample

Investor Folder
o

•

Microsoft Excel Home Tab

Workbook folder – individual assignments, reviews, skill reviews, extension activities

Handouts
o

Company Profiles

o

TechnoStock Exchange Listings

Game Materials
o

Scrap paper, envelopes, calculators

o

Technodollars

o

TechnoStock Certificates

Optional Activities
o

Session 1 Review

Teacher Preparation
•

The Investor folder must be available to students. Detailed instructions are included in the
Preparing to Teach section of this teacher guide.

•

Prepare Company Profiles and TechnoStock Exchange Listings handout.

•

Prepare Technodollars and TechnoStock Certificates.

•

(Optional) Print flashcards.
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Teaching Strategy
In this session, students become stockbrokers. Explain the scenario to students:

ThisEmployed
section
for
teachers
by an
investment
firm, you assume the role of a

stockbroker. Your responsibility is to earn money for your clients.
You will learn how the stock market functions by purchasing
shares in companies listed on the TechnoStock Exchange (TSE).
You will create an investment portfolio to keep track of all
transactions using Microsoft Excel.

explains each assignment
and gives helpful tips.

Assignment 1 Introduction to Spreadsheets
It is essential that students possess basic spreadsheet skills. In this assignment, students are
introduced to the spreadsheet program Microsoft Excel. Once students are familiar with the
terminology, have them complete Assignment 1. Before beginning, discuss the following:
What is a spreadsheet program?
•

A spreadsheet program is a computer application that simulates a paper accounting
worksheet. It displays multiple cells that together make up a grid consisting of rows and
columns; each cell contains either alphanumeric text or numeric values.

What does a spreadsheet program do? A spreadsheet program lets a person:
•

enter information and easily edit what is written in a cell

•

calculate numbers easily

•

track numbers and trends over time

Spreadsheet terminology:
•

worksheet: A worksheet is a page made up of columns and rows.

•

column: A column is a group of cells stacked vertically, one on top of another in a worksheet.

•

column heading: A column heading is the name of the column. This is a letter.

•

row: A row is a group cells that are placed horizontally, beside each other in a worksheet.

•

row heading: A row heading is the name of the row. This is a number.

•

cell: A cell is a box where information is put. A worksheet has many boxes.

•

cell name: A cell name is the location of the box where a column and row meet.
For example, a box in column A - row 2, would be called cell A2.

•

name box: The name box tells the name of the selected cell.

•

formula bar: The formula bar is an area where you can add or change information in a cell.
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Assignment 2 Introduction to Stock Market Terminology
In this assignment, students are introduced to the stock market and how it operates. They learn
terms such as stock, broker, stock exchange, and floor broker.
•

stock: a share of a company, represented by a certificate of ownership.

•

broker: an agent who buys and sells stocks, bonds and other securities for customers, in
return for a fee or commission.

•

stock exchange: a building or place where stocks, bonds and other securities are bought
and sold.

•

floor broker: an agent who buys and sells stocks at the stock exchange for customers
and brokerage houses.

Assignment 3 Playing the Stock Market
In this assignment, students are introduced to the stock market simulation of this project. Students
are grouped into investment teams. Consider keeping groups academically balanced by
assigning at least one member to each group who possesses good reading skills and/or
discussion abilities.
The group is given money (Technodollars) and profiles of the fictitious companies (Company
Profiles). As a team, they decide how many stocks they wish to buy and from which companies.
Then they purchase the stocks from the floor broker (teacher).
Assignment 4 Investment Record Trade 1
In this assignment, students begin to record their investment portfolio. This is used in the following
sessions to track the value of their investments as stock prices vary over time. They list the
companies, number of shares purchased, and cost of share. Then they calculate the total stock
value and cash available.
Assignment 5 Organize Investment Information using Excel
In this assignment, students transfer the data recorded in Assignment 4 to a spreadsheet. They
create a table and then format it using Table Styles to make it attractive, clear and easy to read.
Introduce the symbol
spreadsheet.

* to the students. This represents the multiplication function in a

You may wish to have students view the Investment Portfolio worksheet as a sample of the
completed assignment. Have the students open the completed worksheet from the Investor
folder copied to each workstation.
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Lesson Plan

The Lesson Plan lists the individual

Assignment 1 - Introduction to Spreadsheets

steps in each assignment.

•

Open Microsoft Excel.

•

Label the parts of the Microsoft Excel window including the Ribbon, Formula Bar, Groups,
Title Bar, Name Box, Tabs, Sheet Tabs, Commands, Window controls, and Scroll Bars.

•

Use the mouse pointer, SHIFT key, and CTRL key to select columns. Note the differences
between each method.

•

Use the mouse pointer, SHIFT key, and CTRL key to select rows. Note the differences
between each method.

•

Select a specific cell and note the cell name.

•

Enter text into a cell by either typing it directly into the box or into the formula bar.

•

Resize the width of a column by double clicking in the header and by manually
dragging.

•

Resize the row height.

•

Use the ENTER key, tab key, name box and arrow keys to move from cell to cell.

•

Select a range of cells using the SHIFT key.

•

Exit Microsoft Excel.

Assignment 2 - Introduction to Stock Market Terminology
•

What is the stock market?

•

What is a stock?

•

Who sells stocks?

•

Why do people want to buy stocks?

•

How do I purchase stocks?

Assignment 3 - Playing the Stock Market
•

Assemble materials.

•

Acquire Technodollars.

•

Read Company Profiles and Stock Exchange Listings.

•

Decide on stocks to purchase and record purchases on Investment Record Trade 1

Assignment 4 - Investment Record Trade 1
•

Record Trade 1.

Some pages have been removed from this sample.
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Assignment 5 - Organize Investment Information using Excel
•

Open Microsoft Excel.

•

Add table headings.

•

Add stock names to table.

•

Add remaining headings.

•

Enter investment data into the table.

•

Format the table.

•

Save the investment portfolio.

•

Exit Microsoft Excel.

Learning Objectives
Content Knowledge:
 analyze business data to make educated trade decisions
 study companies on the TSE to determine which are a good investment
 purchase shares in companies listed on the TSE
 understand the purpose of mathematics in the real world
Technical Skills:
Operating Environment
 create a new folder to save work
 open and close a program
Applied Technology:
 organize information using a spreadsheet

Learning Objectives are specified for each

Spreadsheet:
 open, close and save a worksheet
 enter data into a cell
 change the width of a column
 select a particular row or column
 locate a cell by reference
 use the mouse to select a cell
 use the keyboard to add data to a cell
 use the formula bar to add data to a selected cell
 use the arrow, tab and enter keys to move between cells
 format a table to alter its appearance
 use the keyboard and mouse to select a range of cells
 identify parts of a worksheet window – title bar, ribbon, tab, group, command, window
controls, name box, formula bar, column heading, row heading, active cell, sheet tab

of the six sessions in the project.

A checklist of all objectives is provided at
the end of the project in Session 7.
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Assignment 1: Introduction to Spreadsheets

In this assignment, you learn the parts of the
Microsoft Excel window.

Open Microsoft Excel
 Open Microsoft Excel.
 Click Blank workbook.

Students begin with an introduction to
the Microsoft Excel window.

Label the Parts of the Microsoft Excel Window

Terms:
 Ribbon
 Formula Bar
 Group
 Title Bar
 Name Box
 Tab
 Sheet Tab
 Command
 File tab

 Help
 Scroll Bars
 Cell

1.
2.
3.
4.

File Tab (Backstage)
Tab
Title Bar
Ribbon

5.
6.
7.
8.

Window controls
Name Box

9.
10.
11.
12.

The Teacher Cell
Guide includes the
answer key.

Copyright © TechnoKids Inc.
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Parts of the Microsoft Excel Window:
Title Bar

A bar at the top of the window that shows the name of the document,
program name, and the control buttons.

File Tab

Located at the left of the tabs on the ribbon, the File tab opens Backstage
view. Backstage View houses commands that affect the document as a
whole, or the application itself. Commands found here include: saving,
opening and closing a document, creating a new document, printing, and
changing Excel options. To return to the document, click the Back button or
press escape.

Ribbon

A band along the top of the window that holds the Quick Access Toolbar, title
bar, tabs, commands, window controls, and other tools.

Name Box

A box that shows the name of the active cell.

Tab

A part of the ribbon used to organize commands that do similar types of
activities. For example, the Insert tab has commands that add objects to the
worksheet.

Window
controls

Control how the document window is displayed on the screen. Minimize the
window to the taskbar, Restore the window (or Maximize Window) to full size,
and Close the window.

Cell

Found on a worksheet, a cell is a rectangular box that is identified by a unique
letter and number combination. You would type your number or text into this
box.

Group

A collection of commands on a tab that do similar actions. For example, the
Alignment group contains commands that change the placement of text in a
cell, such as Left, Center, or Right.

Scroll Bars

Bars used to change the part of the worksheet shown in the window. The
worksheet can be moved up or down using the vertical scroll bar, or to the left
and right using the horizontal scroll bar.

Sheet Tab

A tab at the bottom corner of the window that changes the active worksheet.

Formula Bar

A bar that lets you insert or edit the contents of a cell.

Command

A button, menu, or box that tells the program to do a task. A command often
has a picture that shows the action. For example, the Cut command looks like
a pair of scissors.
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Follow the instructions to learn how to:
• select columns, rows, and cells
• enter text
• move from one cell to another

Working with Columns
Columns are vertical (up and down) groups of cells. The area at the top of each column is
called a column heading. Column headings are labeled alphabetically. The worksheet only
shows a few columns, but Microsoft Excel has a total of 16,384 columns.
column heading

column

 Click on column heading A.
 Click on column heading C.
 Click on column heading E.
1.

What happens when you click on the column headings?
The individual column is selected when the column heading is clicked.

 Now, click on column heading A, hold down the SHIFT key, and then click the column
heading D.
2.

What happens when you click on the column headings?
Columns A, B, C, and D are all selected.

 Click on column heading A, hold down the CTRL key, and then click the column C and E
headings.
3.

What happens when you click on the column headings?

For the paperless classroom, students can answer

Columns A, C, and E only are selected.

the questions in their digital workbooks using the
latest version of Adobe Reader.
The Teacher Guide includes answers.

Copyright © TechnoKids Inc.

1-8

TechnoInvestor | Office 2019

Working with Rows
Rows are horizontal (left to right) groups of cells. The area to the left of each row is called the
row heading. Row headings are labeled numerically. The worksheet only shows a few rows, but
there are over a million rows in Microsoft Excel

row

row heading

 Click on row heading 5.
 Click on row heading 10.
 Click on row heading 15.
4.

Illustrated, step by step instructions
make learning spreadsheet skills fun
and easy.

What happens when you click on the row headings?
The individual row is selected when the row heading is clicked.
 Now, click on row heading 5, hold down the SHIFT key, and then click the row heading 10.

5.

What happens when you click on the row headings?
Rows 5, 6, 7, 8, 9, and 10 are all selected.
 Click on row heading 1, hold down the CTRL key, and then click the row 5 and 10
headings.

6.

What happens when you click on the row headings?
Rows 1, 5, and 10 only are selected.

Working with Cells
A cell is the location where a row and column meet. Cells can hold words, numbers, or
mathematical formulas. Each cell has a name called a cell reference. The cell reference is
shown in the name box. A cell reference is the column and row location. For example, the cell
reference for the cell that intersects column A and row 1 is A1.
name box

selected cell

 With the mouse, click in cell A1 to select it.
 Move the mouse to column D, then count down 2 rows. Click to select the cell.
7.

Look in the name box. What is the cell reference?
D3

Copyright © TechnoKids Inc.
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How to Enter Text
 Select cell A1, type hello.
formula bar
cell

You can add text by typing in
the cell or in the formula bar.

Helpful tips throughout the

 Click the mouse at the end of the word hello in the Formula bar.

assignment ensure success and

 Press the SPACEBAR once and then type the word there.

assist in troubleshooting.
Move from Cell to Cell
 Press the ENTER key to move from cell A1 to cell A2.
 Press the TAB key to move from cell A2 to cell B2.
 Use the mouse to move to cell C3.
 Highlight C3 in the Name box. Type B4, and then press ENTER to select cell B4.

8.

List the different ways you can move from cell to cell.
1) Click the cell directly with the mouse. 2) Use the ENTER key. 3) Use the TAB key.
4) Type the cell reference into the name box.

Copyright © TechnoKids Inc.
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Resize Column Width
 Place the mouse pointer between the column A and column B headers.
 Double click the mouse when the mouse pointer changes to a double arrow.

2
9.

What happens?
The column width automatically resizes to fit the data in the cell.

 Place the mouse pointer between the column A and column B headers.

Questions guide student learning.

 Click and drag the mouse to the right when the mouse pointer changes to a double
arrow.

10.

What happens?
The column width increases to the desired width.

 Place the mouse pointer between the column E and column F headers.
 Click and drag the mouse to the left when the mouse pointer changes to a double
arrow.
11.

What happens?
The column width decreases to the desired width.

Some pages have been removed from this sample.
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Use the Arrow Keys
 Press the UP (↑) ARROW key.
16.

What is the cell reference of the new active cell?
B3

 Press the DOWN (↓) ARROW key.
17.

What is the cell reference of the new active cell?
B4

 Press the RIGHT (→) ARROW key.
18.

What is the cell reference of the new active cell?
C4

 Press the LEFT (←) arrow key.
19.

What is the cell reference of the new active cell?
B4

Select a Range of Cells

In this activity, students learn

Any group of cells (two or more) is called a range. The range address is defined by noting the
first and last cells in the range separated by a colon (:).

spreadsheet skills including:

 Click the mouse in cell A1 to select it.

✓ enter data into cells

 Press the SHIFT key and click to select cell D6.
20.

✓ select a row or column

What is the range address of the selected cells?
A1:D6

✓ change the width of a column
✓ locate a cell by reference

Exit Microsoft Excel

✓ use multiple methods to move

 Click the File tab and choose Close.
 Do not save the changes.

Copyright © TechnoKids Inc.
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Assignment 2: Introduction to Stock Market Terminology

Read the information
below to learn stock
market terminology.

What Is the Stock Market?
You may have been to the market with your mom or dad to buy fruit, vegetables, or flowers. A
market is a place where people come to sell or buy goods. Similarly, the stock market is place
where people buy and sell stocks.
What Is a Stock?
A stock represents ownership in a company. It is a type of investment that buys you a portion or
share of a company.
Who Sells Stocks?
Occasionally, a company may need to raise money so that their
business can continue to grow. They may need new equipment, capital
for an expansion project such as a new production line in their
manufacturing plant, or funds for new technology development.
Everything costs money! Employees, manufacturing, transportation, and
marketing are all expenses. Dividing the ownership of a company is an
excellent method of raising money.
Think of what you do when you need money. Do you ask a friend to loan you money? A loan
means you must pay the money back. If you borrowed money from a friend, you would need to
repay them in the near future. However, it is better to receive money and not have to pay it
back. Parents are great for simply giving you money.
Companies would also much rather receive money and not repay it. If they took a loan from a
bank, they would have to repay the bank. But, if they decide to share their company, they can
sell a portion of it in the form of stocks to other people. Money raised from selling ownership
never has to be paid back!

Next, students are introduced to the stock
market, how it operates, and stock
market terminology.
Copyright © TechnoKids Inc.
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Why Do People Want to Buy Stocks?
Quite simply, people buy stocks to make money. It is a form of investment. When a stock is
purchased, the company uses the money to help their business grow. The growth results in the
company earning more money, causing the stock price to rise. If an investor sold their stock at a
higher price than what they purchased it at, they too, would make money.

Questions confirm students’

For example, let's say you bought a stock in Coca Cola for $50. The company has an excellent
year – they are selling a lot of product, production costs are lower than ever before, and they
have a firm plan for future growth. The stock is now worth $75. That means that you, the investor,
without having to do anything just made $25. That may not sound like much but if you owned
100 stocks in the company you would have earned $2500.

understanding of concepts.
1.

How much money would you have made if you owned 1000 stocks of Coca Cola?
$25,000 WOW! That is a lot of money.

Is it really that simple? Wouldn't everyone who owned stocks in companies be rich?
No, it is not that simple. Sometimes companies do not perform well, they make poor business
decisions or the market changes, and instead of making more money they start to lose money. If
the company loses money what do you think happens to the value of the stock? Yes, that is
right, it goes down.
Let's reexamine the purchase of that stock in Coca Cola for $50.
Say that the company had a bad year and had to recall the
product due to moldy bottles and people getting sick. A
production plant had a fire and they were unable to make
enough cola drinks and now sales are falling. The company is
losing money. Remember, the stock was purchased at $50, but
now the stock is worth only $25. If you, the investor, were to sell your
stock, you would have $25 less than what you originally purchased the stock for. When you
invest in the stock market you can make a lot of money, but you can also lose a lot of money.
2.

If you originally purchased 100 stocks at a cost of $5000, how much money would you
lose if you sold now?
$2,500

3.

What would you have lost if you owned and sold 1000 stocks?
$25,000

4.

What would you have lost if you owned and sold 10,000 stocks?
$250,000

Introductory activities can be completed in the
classroom prior to using computers.
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How Do I Purchase Stocks?
Now that you know that buying stocks can make you money, where do you go to purchase a
stock? As previously mentioned, stocks are sold on the stock market. But the stock market could
be far away from where you live. There are markets in Toronto (Toronto Stock Exchange), New
York (New York Stock Exchange), Tokyo (Tokyo Stock Exchange), and London (London Stock
Exchange). However, you may not be close to any of those locations. No problem! You can go
and visit, telephone, or trade electronically on the Internet with your broker.
Brokers work in places called brokerage houses. Their job is to buy stocks for you from the stock
market. After you contact your broker, he or she sends a message to a person who is working at
the stock market. This person is called a floor broker.
Your broker tells the floor broker what you want to buy. Now the floor broker goes to the part of
the stock market that is allocated to this particular stock and makes the purchase on your
behalf. The trade is then reported using a computer. The floor broker then contacts the broker at
the brokerage house to let him or her know that the transaction is complete. You now have
bought a stock!
A paper stock certificate is then issued as proof that you have made the purchase. Typically
your broker keeps a record of the stock you own rather than sending you the actual certificate.
The process is repeated when you want to sell your stock.
5.

Do you think you would be a good stock broker? Why or why not?

A stock market simulation is a meaningful
way to show students the purpose and
application of mathematics in the real world.

Copyright © TechnoKids Inc.
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Assignment 3: Playing the Stock Market
Throughout this project, you participate in a simulation that replicates trading on the stock
market. You assume the role of a broker working for an investment company. In small
groups you invest 400 Technodollars in companies listed on the TechnoStock Exchange
(TSE). At the beginning of each session, you read the articles printed in Money and
Markets, a business magazine that caters to the leading companies listed on the TSE. With
each issue of Money and Markets various events are published that have an impact on
these companies. With stock values rising and falling, you must be wise investors in order to
make money for your clients. If not, you could lose it ALL!

The TechnoInvestor Resource folder
includes everything teachers need
for a stock market simulation.
Materials
•

Technodollars

•

Scrap paper

•

Stock Certificates

•

Calculators

•

Company Profiles

•

Pencils

•

TechnoStock Exchange Listings

•

Envelopes

Setup
1.

Form small groups of 4 or 5 students.

2.

Obtain 400 Technodollars as listed in the table below.
Denomination

3.

Quantity

Total Value

100

x

1

100

50

x

2

100

20

x

5

100

10

x

5

50

5

x

8

40

1

x

10

10

Acquire a calculator, scrap piece of paper and pencil.
TIP: Click Start and type "calculator" in the search box for the built-in Windows calculator.

4.

The teacher will act as the floor broker responsible for managing the buying and selling
of stocks on the TechnoStock Exchange (TSE). Therefore, he or she will need the
remaining Technodollars and the TechnoStock certificates arranged on a table.

How to Play
5.

Acquire a Company Profiles handout from the teacher.

Students form investment teams
and prepare to trade stocks.

Copyright © TechnoKids Inc.
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6.

Read the information on each company to determine possible investments.

About the Company Profile:

Company profiles describe
eight fictitious companies,
written specifically for

This means that over the
past year the highest price
of the stock was 75.
Technodollars.

middle school students.

This means that over the
past year the lowest price of
the stock was 29.
echnodollars.

This graph shows the value of the
stock over 1 year (52 week)
period. Examining the graph tells
about the value of the stock.
Is it rising or falling?
Is it very volatile? Volatile means it
has sharp increases or decreases
over a short period of time.
Is the value constant? Constant
means it keeps a similar value
over time.

7.

Acquire the TechnoStock Exchange Listings handout. This document contains
information about the amount of money the companies listed are selling for on the TSE.

8.

Use a calculator and scrap paper to plan which stocks to purchase.

9.

Assign a group member to purchase stocks from the floor broker (teacher).

Stock exchange listings show
the value of every company.
Teachers hand out updated
listings during each of the
four trading sessions.

Some pages have been removed from this sample.
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Assignment 4: Investment Record Trade 1
Record Trade 1
Record the trades made by your investment group in the chart below.

Student investment groups

Include the following data:

track
their purchases in
• date
• name of the share purchased
preparation
for entering the
•

number of shares bought

•

total value of stocks owned for each company

•

amount of cash still on hand

data
into
a spreadsheet.
• cost
of share

Once complete, calculate the investment portfolio value by adding together the total stock
values to the amount of cash.
Date:
Name of Share

Number of Shares

Cost of Share

Total Stock Value

Cash Available
Total Investment Portfolio Value

Copyright © TechnoKids Inc.
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Assignment 5: Organize Investment Information Using Excel
Follow the instructions to organize investment information in a table.
Make the table look great using Format as Table - a set of preset styles
or designs to format a range of cells.

Open Microsoft Excel
 Open Microsoft Excel.

Illustrated, step by step

 Click Blank workbook.

instructions show students

Add Table Headings
 Select cell A1. Type Investment Portfolio.
 Select cell A3. Type Date.

how to record their

investment portfolio data in
an Excel spreadsheet.

 Press the TAB key. Cell B3 is now active. In this cell type today's date.
 Click to select cell A4. Type Name of Share.
 Press the TAB key. Cell B4 is now active. Type Number of Shares.
 Press the TAB key. Cell C4 is now active. Type Cost of Share.

 Press the TAB key again. Now cell D4 is active. Type Total Stock Value. Press ENTER.

 To enlarge column A place the mouse pointer between column headings A and B.
 When the mouse pointer changes to a double arrow, double click the mouse button to
automatically resize the column to the fit the cell contents.
 Repeat for columns B, C, and D.

Some pages have been removed from this sample.
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 The Format As Table box opens displaying the range of selected cells. Click to select the
My table has headers option and click OK.

The table is formatted

Range of selected
cells; A4 through D14.

to make it clear and
easy to read.

The most important factor in choosing a style is to make the information
clear and easy to understand.
The colors and styles are there to make the table look great but also to
help the viewer read the words and numbers on the table easily.

Save the Investment Portfolio
 Click the File tab and select Save.
Go to the place where you save your work. (Ask your teacher where to save your work.)
 Click the tool that makes a new folder.
Name the new folder Investor.
 Press ENTER.
 Select the new folder and click Open.
 In the File name box, type Investment Portfolio.
 Click Save.

Exit Microsoft Excel
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Session 1 Review: Stock Market and Spreadsheet Checkup

Answer True (T) or False (F) to the following
questions.

Review lessons at the end of

1.

Stocks are items found in the storeroom of a grocery store.

T or F

sessions provide activities to check

A stock is a type of investment that buys you a portion or share of a
and reinforce
newly learned skills,
company.

2.

T or F

concepts,
and from
terminology.
Money raised
selling ownership has to be paid back.

T or F

4.

When a stock is purchased, the company uses the money to help their
business grow.

T or F

5.

Everyone who owns stocks in companies is rich.

T or F

6.

A broker's job is to buy stocks for you from the stock market.

T or F

7.

You can trade stocks by telephone, electronically, or speaking directly
with your broker.

T or F

8.

Brokers work in places called stock markets.

T or F

9.

Whether a company makes or loses money has little or no effect on stock
value.

T or F

10.

After you contact your broker, he or she contacts a floor broker.

T or F

3.

/10

Teacher Guides include answers.
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Session 1 Extension Activity: Track the Stock Market on the Internet
Find out about different companies that sell stocks.

Extension Activities at the end of sessions

You will need:
•

A web browser

provide
optional
enrichment challenges.
• Microsoft
Excel
Internet Research: About Stocks
1.

Access the site http://finance.yahoo.com/ and use the symbol lookup feature in order
to find the ticker symbols for the companies listed in the table below. Once you find
the ticker symbol, fill in the table for each company.

2.

In the last row of the table, select a company of your own choosing and complete the
chart with its information.

TIP: If necessary, change the fractions to a
decimal. For example, 25 ¾ = $25.75. Do this in
order to determine how much money you will be
spending when the main portfolio is created.

Company Name

Ticker Symbol Opening Price Previous Close 52 Week High 52 Week Low

Apple Inc.
Air Canada
McDonald's Corp.
Sony Corporation
Microsoft Corporation

3.

Open Microsoft Excel and create a worksheet to track this information. Apply your
knowledge to format the worksheet.

4.

Save the workbook to your student folder as Portfolio2.
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